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Procedure for General Use of the XPS 
Updated 10/22/2018 

 
Loading a sample into the XPS:  

1) Fill out the XPS logbook on the computer desk.  Make a note of the pressure readings of IG1 
and IG2 on the valve control panel over the XPS, the time you sign in, and your sample 
material.  Unusually high pressures (ca. IG1 > 10-7 or IG2 > 10-8  Torr) could indicate a 
problem with the instrument and should be brought to the attention of a GLA.  

2) Check the control panel to make sure that gates 3 (N2) and 5 (analysis chamber) are closed 
and that gates 2 (load lock/turbo), 6 (XPS/cryo), and 0 (Load/Lock cryo) are open. XPS stage 
(control 7) can be up (light on) or down. The switch for gate 0 is attached to the left side of 
the XPS table.  

3) Read the pressure in the back chamber on the 
control unit sitting on top of the control panel 
for the gates.  The pressure should read ≈ 10-4 or 
0 Torr (the lowest the capacitance gauge can 
read).  The pressure in the load lock is 
observable on the left ion gauge above the 
control panel.   

4) Check that no samples are in the instrument in 
either the analysis chamber or the load lock.  If 
there is a stub already in the instrument, you 
will need to unload it before you can load your 
own stub.  Do so by following the unloading procedure, starting on page 7. 

5) Mount your sample on the XPS stub.  
a) Stubs should be handled only while wearing gloves, and should be stored in a clean, 

sealed container.  Please do not remove stubs from the XPS room.   
b) There are two types of public-use stubs in glass jars on the counter. 

For thin samples (0-5mm): use one of the tall stubs from the glass jars marked 
with yellow tape. 
For thick samples (5mm-1cm): use the short stub from the glass jar marked with 
blue tape. 

c) Wipe the stub with a Kimwipe moistened with isopropanol before use.  Only wipe the top 
of the stub. 

d) Use the screws on the stub to mount your sample securely. If you must use carbon tape 
(only UHV carbon tape is allowed), use only a very small amount and do not load more 
than 3 samples with carbon tape at one time. The screws are preferable; so only use 
carbon tape if absolutely necessary. 

e) Samples should not extend past the edges of the stub. 

6) To bring the load lock up to atmospheric pressure:  

Do Not Remove 
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a) If gate 1 is closed, open it now. 
b) Turn off IG1. 
c) Close gate 0 to the load lock cryo pump, (switch left 

side of XPS table). 
d) Turn off the load lock turbo (Pfieffer) pump by 

pressing the “ON/OFF” button on the Pfieffer 
controller to the left of the valve control panel.  The 
mechanical vacuum pump on the floor will turn off 
automatically.  

e) Close gate 2 (load lock/turbo) and wait until you hear 
the gate click shut.  

f) Once gate 2 is closed, open gate 3 (load lock N2).  The 
pressure in the load lock will increase as N2 fills the 
chamber.  When the pressure reads approximately 720 
Torr, the door to the load lock should open. To easily 
remember these steps think “0,off,2,3,”. 

7) Place the stub onto the load lock arm using the bottom 
notch (see image on page). The stub has a freely rotating 
spindle below a short, cylindrical collar (see image on 
page).  The bottom notch of the spindle should fit snugly 
into the arm.  Rotate the magnet on the arm to lock the 
stub in place.  Close the load lock door. 

8) Check that the turbo is stopped.  If it is not, wait until it 
reads 0 Hz.  The speed of the turbo is shown on the turbo 
controller. It takes about 5 minutes for the turbo pump to stop spinning. 

9) Close gate 3 (load lock N2) and open gate 2 (load lock/turbo).  While holding the door 
closed, turn on the turbo pump by pressing the "On/Off" button on the right side of the “Load 
Lock Turbo” control panel (3,2,on). Watch the pressure in the back chamber; it should 
decrease continuously to the low 10-3 Torr range. The turbo pump occasionally will hang at a 
pressure, if this persists for 30 seconds or more, turn off the turbo pump, wait for it to spin 
down, and restart it.  

10) After a few minutes, the turbo pump should reach maximum speed (1500 Hz) and stabilize in 
power (0-7W). 

11) When the pressure reaches < 1 x 10-4 Torr, turn on 
IG1.  

12) When the pressure is < 7 ´ 10-5 Torr, open the gate 0 
to the load lock cryo and close gate 1.  Wait for 30 to 
60 minutes for the pressure to reduce. If the pressure is 
decreasing very slowly your sample is outgassing. 
Open gate 1 for the first 30–60 minutes to increase 
pumping capacity. 

Loading Samples Summary 
1. check no stub in XPS 
2. Check Turbo on & back 

chamber at low pressure  
3. open gate 1 
4. turn off IG1 
5. close gate 0 
6. Pfeiffer (Turbo) off 
7. close gate 2 
8. Wait for gate 2 to close 
9. open gate 3 
10. load stub, use bottom 

notch; 
11. wait for Pfieffer to stop 
12. hold door, close gate 3 
13. open gate 2 
14. Turn on Pfeiffer Turbo 
15. wait for back chamber   

< 1 x 10-4 Torr 
16. turn on IG1 
17. open gate 0 
18. close gate 1 
19. wait >½ hour till IG1     

< 5 x 10-8 Torr 
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Moving a sample into the XPS chamber:  
1. After 30 minutes check the pressure in the load lock.  It should read < 5×10-8 Torr.  If not 

wait longer.  

2. Raise the stage by moving switch 7 up. 

3. Open the Motion Control Panel (found in the “View” drop down menu). Move the stage so 
that x, y, and z all equal 0. 

4. Lower the stage by moving switch 7 down (light is off).  

5. Center the stage in x and y directions. 

6. Make sure that the transfer arm is fully retracted (otherwise gate 5 will not operate). 

7. Open gate 5 (to XPS chamber).  This gate may take 10 s to fully open. Switch on the light in 
the analysis chamber.  

8. Use the transfer arm to move the stub into the analysis chamber, stopping the magnet of the 
transfer arm at the beginning of the ‘CAUTION” region on the arm (about a foot from the 
end of the table).  

9. Move the transfer arm slowly when placing the stub on the 
stage.  The stub is fully on the stage when the collar above 
the stub spindle completely overlaps the semicircular wear 
mark on the stage. If you cannot load the sample using 
minimal pressure, contact a GLA. Do not use excessive 
pressure. Doing so has damaged the stage in the past. 

10. Unlock the stub from the transfer arm.   

11. While watching the stub on the sample stage, withdraw the 
transfer arm.  If the stub starts to move push it back onto the 
stage and try again.  If you cannot get the stub to stay on the 
stage call a GLA. 

12. Fully retract the transfer arm to the load lock chamber, and 
close gate 5 (to XPS chamber). 

13. Raise switch 7.  This lifts the stage into the appropriate 
position to collect data.  If the gears on the stage and the 
stub do not mesh, try rotating the joystick. 

  

Moving sample to XPS Stage 
1. IG1 < 5´10-8 
2. Raise stage switch 7 
3. Move stage to position 

(0,0,0,0) 
4. Lower Stage switch 7 
5. Center stage in x and y 
6. Make sure transfer arm 

fully retracted. 
7. Open gate 5 
8. Push sample with  

transfer arm onto Stage 
9. Unlock sample from 

arm 
10. Fully retract transfer 

arm to LL 
11.  Close gate 5 
12. Raise stage (switch 7) 
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Collecting XP spectra:  
1. The computer should be on.  If not, the computer is located at the back right side of the 

instrument, behind the analysis chamber. Log in using the ID and password posted on the 
monitor.  If the computer is restarted you will need to reengage the joystick controls.  To do 
this, first click on the snoopy icon in the taskbar. Then, start the “ESCA Capture” program 
and go to View=>Motion Control Pnl.  If the button labeled “Joystick” is red, click on it and 
it should turn green.  

2. Turn on the desk lamp. 

3. If it is not already open, open MicroViewer 5MP camera software. Note the camera is upside 
down. Position the window so that the center of the small crosshair icon at the top of the 
window lines up with the upper black cross on the right monitor.  This ensures that the lower 
cross near the center of the screen reflects where the X-rays will hit the sample. Do not right 
click within the camera window, doing so will move the program’s crosshairs. If the program 
crosshair does not align with the lower black cross in the center of the monitor right click on 
the screen to move the crosshair to that position. 

4. Make sure that the 9600 (on the electronics rack) has the button for computer lit (push the 
button if it is off). 

5. Open your personal database in ESCA Capture.  You may have to go to View=>ESCA 
Control Pnl and check the ‘Xray Gun Operate’ box to turn on the high voltage to the gun by 
switching the gun controller from standby to operate.   

6. To find the correct z position for the sample, in the 
ESCA Control Panel set “CBE” to an energy for 
an element in your sample. A CBE of 285 for C 1s 
or 533 for O 1s should be suitable for most 
samples. Select a spot size of 800, a Res# of 4, and 
a “Cap” value of 5:00. If the box that should say 
“Cap” reads “Avg”, it can be switched back to 
“Cap” by clicking on it. The “Scans” box should 
be unchecked. 

7. Verify that the pressure read by IG2 is < 2 x 10-8. 
Move the sample under the lower black cross on 
the screen. Click the Start box and adjust the z 
position of the sample until the count rate reads 
>500.  Flip the Auto Z switch to the right of the 
joystick from off to on. Watch the count rate 
increase. Wait at least 10 seconds. Make sure that 
your sample is still under the lower black cross. If 
it is not, navigate to the desired position on your 
sample. Once the count rate has stabilized, switch the Auto Z switch to off.  Once the sample 
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is at the correct height, change the spot size to “Spot Off” and click Start. You can now close 
the ESCA Control Panel. 

8. To collect a survey scan of the sample, make sure the “recipes” button is selected in the 
upper left-hand corner of the screen.  Select the project and recipe file that contains the 
appropriate scan parameters.  Recipe parameters are shown in the right-hand dialog box.  
Along the far right-hand side of the box are buttons that add, delete, and move regions within 
a recipe.  Following are brief descriptions of some common region parameters that are used 
often: 

A. Survey scan from 0-1000 BeV 
i. Function: Survey 

ii. LBE (low binding energy): 0 
iii. Window width: 1000 
iv. Spot size: 800 
v. Scans: 2 

vi. Res #: 4 
vii. eV/step: 1 

B. Detailed scan of the Si 2p peak 
i. Functions: ResHi 

ii. CBE (center binding energy): 101.5  
iii. Window width: 8 
iv. Spot size: L2 or L3 
v. Scans: 20 

vi. Res #: 1 or 2 
vii. eV/step: 0.065 

 
L3 produces a signal with twice the count rate of L2 at the expense of slight peak broadening (on 
the order of ~35 meV difference in FWHM). Using Res 2 will increase the count rate by a factor 
of ~4 relative to Res 1, but using Res 2 comes with substantial linewidth broadening (~160 meV 
FWHM difference). Users are encouraged to determine what settings are best for their specific 
samples. 
 

C. Shut off x-rays after a set of scans (always add this step to the end of a recipe) 
i. Function: Survey 

ii. LBE (low binding energy): 0 
iii. Window width: 1 
iv. Spot size: off 
v. Scans: 1 

vi. Res #: 4 
vii. eV/step: 1 

 
The available spot sizes for the M-Probe are shown in the table below: 
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Spot Size (µm) 
800 
500 
300 
100 
L1 (100x400) 
L2 (250x1000) 
L3 (500x1200) 

 
9. The last region in every scan must have the “spot size” set to “Off.”  This is the only 

way to turn off the X-ray source.   

10. Save your recipe.   

11. You may use the autosampler function to analyze multiple samples without coming back to 
move the stage. Contact a GLA if you have not been trained on its operation. 

12. In the lower right-hand region of the screen, name your project and experiment.  You can add 
a description of your experiment.  Avoid using parenthesis, colons, semicolons, dashes, or 
underscores in your file names.  

13. Make sure that the analysis chamber pressure is <2 x 10-8 and dropping. Do not 
commence your run if it is not. In the main program window choose the button labeled 
“Run” at the top of the screen.  

14. At the end of the scan, the file may be opened by selecting the “Experiment” button in the 
upper left-hand corner of the screen.  The data is saved automatically and will only be 
removed if you save over it; we recommend that you periodically backup your 
database/protocol to a thumb drive.  Data may be analyzed using a variety of techniques 
given in the data reduction program.  See the blue binder or a GLA for more information.  

15. Export data to an Excel or Vamas (CasaXPS) file.  This can be done either from either the 
ESCA Capture or ESCA Analysis program. Select which experiment to export, and then 
choose Export from the File menu.  Select “EXCEL” or VAMAS in the dialog box. Excel 
files will show every region of your scan in a different sheet of the workbook.  Save this to a 
disk.  You are responsible for exporting and saving your own data; the MMRC and the XPS 
GLA are not responsible for lost data.   
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Procedure for aligning the camera crosshairs with the X-ray spot 
1. Follow this procedure if you or someone accidentally right clicks in the camera software and 

moves the position of the crosshairs from the set location. 

2. Close the MicroViewer 5MP camera software and reopen it from the desktop icon. This 
ensures the software window is sized correctly. Do not maximize the software. 

3. Move the window to the right monitor and line up the crosshair icon in the top toolbar with 
the upper black cross on the monitor. In this position, with the window this size, the lower 
black cross on the screen marks the center of the X-ray spot.  

4. Right click in the camera software where the black cross is to realign the crosshairs with the 
lower black cross to mark the X-ray spot on the sample.  

 

Unloading the sample: 
1. Move the stage to the (0,0,0,0) position using the Motion 

Control Panel (found in the “View” drop down menu). 

2. Lower switch 7 to lower the stage. 

3. Check that the load lock is at low pressure < 5 x 10-8 Torr. 

4. Check that the transfer arm is fully retracted. 

5. Open gate 5.  

6. Placing the stub on the transfer arm. Make sure the transfer 
arm fork is closed. Push the transfer arm fork onto the stub. 
Turn the magnet 180° to lock the stub on the transfer arm. 

7. Fully retract the transfer arm into the load lock  

8. Close gate 5 (to XPS chamber). 

9. Open gate 1 (load lock/back chamber), close gate 0 (load 
lock cryo pump), and turn off IG1. 

10. Turn off turbo, close gate 2, and wait till it is closed 

11. Open gate 3 to let N2 into the load lock.  

12. When the pressure in the back chamber is ~ 760 the load 
lock door should open.  

13. Remove stub and wait for the turbo to stop spinning. 

Unloading Sample Summary 
1. check IG1 < 5 x 10-8 

Torr 
2. Move stage to position 

(0,0,0,0)  
3. lower stage (gate 7) 
4. Make sure transfer arm 

fully retracted 
5. open gate 5 
6. move stub from XPS 

stage to arm 
7. move stub to load lock 
8. Check that the transfer 

arm is fully retract. 
9. close gate 5 
10. open gate 1 
11. close gate 0 
12. turn off IG1 
13. turn off Pfeiffer 
14. close gate 2 
15. Wait for gate 2 to close 
16. open gate 3 
17. remove sample 
18. wait for Pfeiffer to stop 
19. hold door, close gate 3 
20. open gate 2 
21. start Pfeiffer. 
22. wait for P < 1x10-4 Torr 
23. open gate 0 
24. close gate 1,turn on IG1 
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14. While holding the door closed, close gate 3, open gate 2, turn turbo on (3, 2, on). 

15. Sign out in the logbook and note any problems or observations while using the instrument. 

16.  When the turbo reaches full speed and the pressure is < 10-4 Torr, open gate 0 and close gate 
1. Turn on IG1. 

17. When you leave, the load lock should be under stable vacuum with the turbo pump at max 
speed,  

a. gates 2, 6 & 0 should be open and  

b. all others (1, 3, 4, 5) should be closed, and IG1 and IG2 should be reading normal 
low pressures  (mid 10-9 Torr or lower). 

Send questions to  
Ellen Yan: eyan@caltech.edu; x3964 
Annelise Thompson: athompso@caltech.edu; x3964 
Michael Mazza: mmazza@caltech.edu; x3964 
Maureen Morla: mmorla@caltech.edu; x   
 


